
WinTV-HVR-930
Quick Installation Guide for Windows 

● WinTV-HVR-930 PAL/DVB-C/DVB-T receiver

● USB extension cable

● AV cable (on some
models)

● Portable TV antenna 
(on some models)

● Credit card size remote
control (on some models)

● WinTV Installation CD-ROM including the WinTV v8
application 

1. Contents of the WinTV-HVR-930 package

Plug the A/V input cable into the small connector on the side
of the WinTV-HVR-930. Connect your A/V source using either
the Composite or S-Video connection and the audio jacks.

To enable the external A/V source in the WinTV application, see
the section entitled “External audio/video sources” below.
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Select your language,
then click the button
labeled: Step 1: Install
Drivers. A blue screen
will open and begin
installing the drivers for
your WinTV.

Once the drivers have
installed, click on the
Finish bar to exit.

Install the WinTV
applications

Click the button
labeled Step 2:
Install WinTV 

Click Next.  

The setup
application will
then open and
begin
automatically
installing the WinTV application components.

The main application installed is the WinTV v8 application for
TV watching and recording. 

At the conclusion of the installation, you will be asked to Enter
Serial Number. You can find the serial number on your WinTV
v8 CD.

Once complete, click OK then Exit.

To install WinTV v8 on a PC or laptop without a CD-ROM
drive

If your PC or laptop does not have a CD-ROM drive, do the
following:

To run the WinTV v8 application, double click
on the WinTV icon on your Windows desk top. 

When you run WinTV for the first time, the WinTV
Device Setup Wizard appears. Select the TV
source that you are using. On some model

WinTVs, you have multiple tuners and therefore you can select
multiple sources.

If your TV source is Freeview DVB-T digital over-the-air
TV

Select Digital DVB-
T and click Next. In
the DVB-T Setup
menu, click Next.
You will see the
DVB-T Scan
scanning for digital
over-the-air
channels. 

The digital TV
scanning process will scan from channels 2 to 51.  As TV
channels are found, they will appear in the Channel box.

When complete, click Next / Next and OK.

Note: if you do not receive any digital TV channels, an antenna
signal booster might be needed. After adding a signal boost-

er, see below for instructions on rescanning and the
Troubleshooting section for information on choosing an antenna.

If your TV source is DVB-C Digital Cable TV

DVB-C digital cable TV channels are those TV channels
broadcast on a
digital cable
network which are
unencrypted (‘free
to view’). If you
have a cable
operator who
transmits DVB-C
digital TV programs,
chose Digital DVB-
C and Next.

Encrypted channels are automatically not selected. The
resulting channels in the list might be both standard and high
definition channels.

If your TV source is Analog cable TV

Select your
Country and
your TV Source
from the drop
down list. To
automatically
scan for
channels, click
Next to continue.

Click the Scan
button and
WinTV will
automatically scan for analog channels. The scanning process
takes about 10 minutes. 

External audio/video sources

You can bring video into the WinTV from an external audio/video
source such as a cable TV or satellite set top box. 

In the Device Setup Wizard, select External Inputs and click
Next.

You will be
presented with
the option to
add a
Composite
and an S-
Video Input.
Please select
your country (if
not correct)
and click Next.

If you wish to connect a source not normally designed for
operation in your country, you can configure the Video Format
manually from the drop down list. Change the value from
“AUTO”. Pal BGHIDK is the commonly used format in Europe.
NTSC is the broadcast format used in North America.

Rescanning TV channels

If you want to rescan for TV channels, click the Configuration
menu (Gear button in the lower left corner of WinTV v8). 

Then click on the Devices tab. Chose your WinTV device by
clicking on it, then click Tuner setup. Chose the TV format you
want to scan, then click Next. Click Next and a new scan will be
started. When the scan is complete, click Next / Next and OK.

Once the WinTV v8 application is open, click the Watch TV
button to watch TV .

To see the TV Channel list, click your right mouse button in
the TV window to display the Options menu. Select Find
Channel. You will see the channel list.

To display the channel list all the time, while the channel list is
displayed, click the Channel list display always on button.

Options menu

The Options menu is the main menu where you can select
channels, turn on close captions, open the TV Scheduler, show
the TV Guide and many other of the most important TV control
functions.

To bring up the Options Menu, click your right mouse
button once in the TV window.

To see the channel list, click on Find channel. You will see
the list of channels which have been scanned. To show the
Channel menu as part of the TV window, click the Channel list
always on icon at the top of the channel list.

To turn on Close captions, click on Show Captions.

5. Using the WinTV v8 application
4. Running WinTV v8 for the first time

Note: the latest WinTV-HVR-930 software can be found at
www.hauppauge.co.uk/wintv8

Note: You may need to disable your antivirus programs during
the installation only.

Install your WinTV product (step 2). Turn on your PC, and boot
into Windows.

For Windows 10, 8 or 7:
You will see an AutoPlay mes-
sage. Click Run Setup.exe 

For Windows XP installa-
tions:

After you install your WinTV
device and boot Windows, a
'Found New Hardware' wizard
will appear. 

Please cancel it and allow Windows to load fully before
proceeding. With some WinTV products, you might see this
message two or three times. Please click ‘Cancel’ each time
you see the New Hardware Wizard.

For all versions of Windows: The “WinTV v8 Setup” win-
dow will appear on the screen.

N ote: if the CD does not autorun, navigate to the CD and
run the 'Setup.exe' file.

3. Installing the WinTV-HVR-930 software

- Download the WinTV v8 application from our website:
www.hauppauge.co.uk/wintv8

- Follow the instructions to install WinTV v8

You will need the Serial number from your WinTV v8 CD-
ROM which came with your WinTV-HVR-930
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Locate a free USB 2.0 port (normally located at the side or back
on the laptop or desktop). Plug the WinTV-HVR-930 into the
USB 2.0 port. The USB extension cable can be used to
position the WinTV-HVR-930 away from your USB slot. 

Note: we do not recommend connecting via a USB Hub.

Plug an antenna for DVB-T (Freeview) TV reception, or either
cable TV or a TV antenna for analog/DVB-CTV reception, into
the TV connector on WinTV-HVR-930. 

When using Freeview DVB-T, it is recommended to
connect to a roof top aerial during the first time
installation. This will provide better signal quality then a
portable antenna.

Indicator LEDs

The Active LED will be lit when the WinTV-HVR-930 has been
activated by Windows (device driver is loaded). The Digital
signal quality LED is green when you are tuned to a strong
digital TV signal, yellow when tuned to a moderate TV signal
and off when there is no (or a weak) TV signal.

Connecting an external A/V source

You can also connect sources via the A/V input cable (available
on some models of WinTV-HVR-930). 

2. Installing the WinTV-HVR-930 device
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Radio Interference Statement:

The WinTV products have been tested and found to comply with the limits

for a Class B digital device, pursuant to part 15 of the FCC Rules. These

limits are designed to provide reasonable protection against harmful

interference in a residential installation. 

FCC ID: H90WINTV

CE Statement: This equipment has been tested and complies with EN

55013, EN 55020 and IEC 801-3 part 3 standards.

CAUTION: Changes or modifications not expressly approved by the party

responsible for compliance to the FCC Rules could void the user's

authority to operate the equipment.

FCC Statement
Note: the latest WinTV-HVR-955Q software can be found at  

http://www.hauppauge.com/site/support/support_hvr950Q.ht
ml

Some notes on system compatibility

Decoding high definition ATSC TV is very CPU intensive. A
graphics card with at least 64MBytes of memory and the latest
graphics driver from the manufacturer makes the decoding task
easier. Typically a 2.2 GHz Pentium 4 processor or equivalent
with a graphics card having 64MBytes of memory is required to
properly decode ATSC digital TV on your PC. A 1.6GHz AMD
Sempro laptop computer tested in the Hauppauge lab used
50% of the CPU for playing ATSC 640i format, and 90% of the

Keyboard shortcuts

To manually schedule a TV recording, or to see which
programs have been scheduled, click on Scheduler.

To turn on the Always on Top mode, click on Stay on Top.

Watch, Pause and Record TV
WinTV v8 is always recording video to your PC’s hard drive
while TV is being displayed. In this way, you can immediately
skip back and replay the TV program you are watching. 

Clicking on the Pause button will cause the video to pause,
while clicking the Record button will cause the current TV
program to be recorded to hard disk.

Recording your TV shows

If you want to record a TV show you are watching:

- Click the Record button. The recorded file name will
popup on the video for a few seconds as the recording
starts.

- When you are finished recording, click the Stop button.

- Click the Playback file button and select the last file
recorded to play the video you just recorded

- To play a video you recorded earlier, click the Playback
File button and then move your mouse and click once on
the video you want to play. Click Open and the file will start
playing. 

The recorded video file is saved in the directory set in
Recordings directory. The default directory is MyVideos. To
change this directory, click the Settings button and then the
Folders tab. Every time you record a file, a new file is
automatically created. The file will be formatted as:
(ChannelNumber)_(ChannelName)YearMonthDay_TIme. 

For digital TV programs, the quality level recorded is the same
as it is transmitted by the TV station. For example, if the TV
station is transmitting a high-definition program, WinTV will
record the program in high-definition.

Close captions, parental control information and SAP audio is
recorded with digital TV programs.

For analog cable TV using the built-in hardware MPEG-2
encoder, the quality of the video recording is set to 6Mbits/sec.
This will be a configurable setting in a future version of WinTV
v8. 

If you want to pause a TV show you are watching:

- Click the Pause button. Your TV video will stop and the
Time counter will start counting.

- To start the video from where you paused, click the Play
button

- To rewind the video to the beginning, click the Skip to the
beginning button. If your video was paused, click the Play
button.

- To rewind the video 1 minute, click the Skip back 1 minute
button. If your video was paused, click the Play button.

The Delay counter displays how much time you are behind the
live video. For example, if the delay counter says 00:01:23, then
the video window is showing video 1 minute and 23 seconds
behind live video.

Image capture
To capture still images from video, click the Snapshot button.

To configure the formats for still image capture, click the
Settings menu button, then click on the Capture folder. You
will see the settings for image capture under Snapshots. You
can chose between BMP and JPEG formats. The name of the
files will be:

capture_’date’_’time’.jpg or capture_’date’_’time’.bmp

TV Scheduler
WinTV v8’s built-in TV Scheduler allows you to schedule the
recording of TV shows. Once a record event is set, WinTV v8
can be closed and will “wake up” at the desired time and tuned
to the desired channel.

Note: your PC needs to be turned on for scheduled recording
to work.

Ctrl A Aspect ratio 

Ctrl D Display the video
and audio format
of the TV program 

Ctrl F Freeze the video 

Ctrl Z Open TV
Scheduler 

Ctrl O View program
details (digital TV
program, where
provided in the
broadcast) 

Ctrl S Display subtitles 

Ctrl W Full screen toggle 

Alt F Open File menu
for playback 

Alt M Open the Task
Menu 

Alt P Previous channel 

Ctrl Q Pause 

Ctrl P Play 

Alt R Record 

Alt S Stop 

Alt T Start TV 

Ctrl C Catch up 

Ctrl > Skip ahead 

Ctrl < Skip back 

TV Tuner set up in Windows Media Center

Run the Windows Media Center application. Cursor down to
Tasks. Cursor left to Settings. Click Enter.

Cursor down to TV. Click Enter.

Cursor down to Set up TV Signal. Click Enter.  Click Next. 

In Confirm your Region, make sure your region is selected.
Click Next. 

You will see a message which says Download TV Setup
options. This takes about 5 minutes to complete. Click Next
when this download is complete.

At TV Signal, click 'I will configure my TV signal manually'
and click Next.

You will then see: Cable / Satellite / Antenna. Chose the
source of your TV signal (Cable for use with analog cable TV,
Satellite for use with a satellite set top box and Antenna for
use with ATSC digital over the air TV) and click Next.

At this point, Media Center will set up the TV tuner. This might
take a minute or so.

Note: Windows 7 Media Center supports QAM TV channels.
You can also use the Hauppauge WinTV v8  application, or

SageTV or BeyondTV for QAM TV reception,

You will then see a message saying Exami   ning cable TV,
antenna or set top box connection.

After determining the type of signal, you will see You are Done!

Click through the rest of the settings, set up your Guide
listings and click Finish. 

Then return to the main menu. Go to TV + Movies and then
Live TV to watch and record TV.

Install the Media Center Remote control
(available in WinTV Media Center Kits)

CPU when playing ATSC 1080i, the highest definition ATSC
format.

In some cases, either a faster processor or more graphics
memory might be required. Slow or jerky video and a noisy TV
picture indicate system performance problems.

Jerky video with live ATSC digital TV

Jerky or distorted video can be caused by two things in your PC
or laptop: a slow CPU which cannot decode the ATSC TV signal
fast enough, and a graphics system which cannot keep up with
the high datarates of ATSC TV.

Many times, improving the performance of the graphics display
will fix the jerky video display of ATSC digital TV.  Here are some
tips on improving graphics performance:

- Use the latest graphics driver: graphics drivers are often
‘tweaked’ to improve performance, especially the built-in
graphics on laptops. Check the Microsoft Windows update site
to download the latest graphics driver for your computer. For
Dell computers, check the Dell website for the latest graphics
driver.

- Use WinTV v8 Video Renderer settings to optimize
graphics performance: The Video Renderer is found in the
General tab of WinTV v8, and is used to change the display
mode of a graphics card for TV watching. This setting does not
affect any other Windows program. 

The default mode is EVR. The other modes are VMR9, VMR7
and Overlay. Each mode uses a different process to render
video. Try each mode and use the one which gives you the best
results. 

To use hardware graphics acceleration, put a check in the
tick box Use hardware acceleration when possible. This will
allow your graphics system to use hardware acceleration for
video decode. Note: graphics hardware acceleration does not
work on all systems. 

If this setting does not help, or if you experience WinTV not
responding after a channel change, then your graphics system

Troubleshooting

When a scheduled record event takes place, the WinTV v8
application records “in background” so that you can continue to
watch your live TV program, even as the recording progresses.

The TV Scheduler can be found in the WinTV v8 Options
menu. Right click your mouse button in the TV window to see
the Options menu. Click Scheduler. To set up an event for
timed watching or recording, click the Add button. 

The items that need to be set for each event are:

- Name: you can add a name to the recording. If you do not
enter a name, the name will be in the channel/date format.

- Channel: chose one of your scanned channels. 

- Start time: set to the desired start time. Click on the hour
to set the hour, the minute to set the minute. Note: It takes
about 15 seconds to launch the WinTV and start recording.

- Duration: number of minutes in the recorded program. 

- Recurrance: one time, daily, weekly. Note: If you set for
Record Weekly, you must also specify the Day of the Week
for the recording.

- Date to Begin Program: today's date is the default.
Change this if you want to schedule on another date.

- Source selection: leave set at WinTV to bring up the WinTV
at the requested time and on the requested channel.

Once these are set, click OK. You can add more recordings,
clicking OK after each event is set. 

When you are finished click Close. 

The WinTV program does not have to be running for the
Schedular
to work, but
your PC
needs to be
turned on.
If WinTV is
not
running, it
takes about
15 seconds
to start
WinTV and
to start the
recording
of TV.
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cannot use hardware graphics acceleration. In this case go
back to settings and uncheck “use hardware acceleration” and
rerun WinTV. 

Only some channels are found during ATSC channel scan

If you are only receiving some known TV channels when
scanning, it means your TV antenna is not adequate to pick up
the channel. You will need either an antenna signal booster (a
Radio Shack antenna amplifier will work) or a high gain antenna.
Here’s a link to an ATSC antenna selector:

http://www.antennaweb.org/aw/address.aspx

Black window when selecting an ATSC channel

A black window when selecting an ATSC channel means that
the WinTV-HVR-850 is not getting a signal. This is most often
due to poor reception. See “Only some channels are found
during ATSC channel scan” above. 

Uninstalling the WinTV driver and applications

Run the hcwclear.exe from the installation CD. Select OK A
black screen will briefly appear and once it has disappeared the
software will be removed. If you now re-start the computer you
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